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About Using Adult Acquired Overlays

My Device has Unity in all the user areas. How can | put the Adult Acquired areas in?
1. First, check the software version of your device.
e Go to the Toolbox
e Select Maintenance Menu
e The version number should be 4.05 or higher.
2. Next hit OK to exit the Maintenance Menu and go to the Choose Overlay Menu
e Select Overlay menu
e Select Load Adult Acquired (All Areas)

e Select Yes (if you want to save any Unity areas, you should select No and do a
memory transfer first.)

e Select OK and Go To Minspeak.
You now see the Adult Acquired Exploration Wizard.

4. To replace Unity programs in all Areas, go to the Toolbox, select Maintenance Menu,
and then select Reset to Factory Defaults.

I have a Vantage or Vanguard software version prior to 4.05. How can | put the Adult
Acquired areas in?

1. You can call PRC sales department and request an update for your device.
e PRC will send you a memory card with instructions for updating.

2. You can download Adult Acquired PASS for older devices from PRC’s web site.
e OnaPC computer you can view and explore all of the Adult Acquired areas.

e You can use the PASS software to do a whole device memory transfer, and then
transfer that MTI file into your Vantage or Vanguard.

e The WordPower areas will not transfer into a device because they are for
demonstration purposes only. To purchase a fully functioning copy of Word Power
for Vantage and Vanguard, call the PRC sales department.

Sales Department: 800-262-1990
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How do I find all the Adult Acquired programs after I have loaded them in?

1. Go to the device Toolbox.

2. Select Choose Overlay Menu, and then Switch User Area.
3. Select Adult Acquired Exploration Wizard; OK; Go to Minspeak.
4. Choose the program you want to explore.
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How can | customize the WordPower programs for an individual?

1. Vantage and Vanguard have a Set-up Key that will help you customize vocabulary. The
Set-up Key is the recessed key at the top right corner on the front of the case. Notice that
when you select this key, you see a prompt on the display that says “Select the key you
wish to modify.” If you select this key by mistake, just select any other key, and then

OK.

The WordPower programs will work better if you do not customize the main page, and

only customize pages where there are blank keys. You can easily add names to the

People Page with the Set-up key.
3. From the Main Screen, select People.
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4. Select the Set-Up Key. At the prompt, choose any blank key on the People Page.

SEESHEHEEEE:
=) ) )=l | | )14
R ENNEEEEEE"
EEEEEEEEEEEE
AN
EENNENE NN

5. Follow the prompts on the next screen to Spell Text for Message, Change Icon, and
Change Label.

6. Select OK when finished.

Choose type of message, then create
message. Select OK when finished.
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How can I customize the 8 location pages in Adult Acquired?

1. To see this 8Adult Page, Go to Toolbox, then Choose Overlay Menu, then Explore
Adult Acquired. Select the light blue key for 8, 15, and 45. Select the 8 Word Cues

key.

[1 want my glasses.

2. Select | want.
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3. Now suppose you don’t want to say glasses, but instead you need the word
chocolate.

Select the Set-up Key, the recessed key at the top right on the front of the device.
You will see a prompt that says, Select the key you wish to modify.

Select Glasses.

Select Clear Key Contents.
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|Choose type of message, then create
l message. Select OK when finished.
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o Next select Spell Text for Message, then spell "chocolate".

e Select Change Icon. You can use the key that says spell icon to find and spell
chocolate.
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e Select the icon that you want.

e Finish by selecting OK.
e You will see your customized page, but you will not be able to leave this page.

chocolate,

a sweater

medicine

e Go to the Toolbox, then select Go to Minspeak, then select 8 Word Cues.
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How do | put names of people in the Word Cues pages?

1. The 8 location Word Cues pages will work better for you if you do not make any
customizations to them. However, in the 8 location area there is a place to put names of

people.

e Use the MORE key on the first screen to go to the next page of 8.
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e Use the Set-up key (the recessed key at the top right corner on the front of the device)
to begin customizing this page.

e Follow the prompts on the screen.

e Select Spell Text for Message.

e Select Change Icon.

e Select Change Label if needed.

e Select Choose Next Key to Define if you want to program another key.
e Select OK to finish.

Putting names of people in the 15 location Word Cues pages works the same way.
e Go to the Toolbox by using the Tools key on the top front of the device.

e Select Choose Overlay Menu, then Switch User Area, then 8, 15, and 45 with
Word Cues. Select OK. Go to Minspeak.

e Select the large 15 icon.
e Select the icon for People.

e Use the Set-up key. When you see the prompt at the top of the page, choose any
blank key on the People page. \
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e Follow the prompts on the screen to Spell Text for Message; Change Icon, Change
Label.

Choose type of message, Then create
message. Select OK when finished.
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or hide as many keys as you want to.

Change
Choose next ke
Key to define i Help Cancel oK
Color

)

To hide keys on a page:
1. Start on the page where you want to hide keys.
2. Select the Set-up Key, the recessed key at the top right on the front of the device.

3. Select any key.
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4. Use either the Hide All key or the Hide/Show Keys key, then follow the prompts on the
screen to hide as many keys as you want. The keys stay fully programmed, and you can
bring them out or show them when you are ready.

Select keys to Hide/Show
Press TOOLS to exit.
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How do | add a page to one of the Adult Acquired programs?

1.

First identify the location where you want to add your new page. A key that is blank is a
good place. Remember that WordPower, Word Core and Word Cues may not be easy to
customize by adding pages. Be sure that you understand the architecture of these
particular programs before altering them.

As an example, let’s add a page to the ABC + pages.

Go to Tools, Choose Overlay Menu, Switch User Area, then Explore Adult Acquired.
OK. Go to Minspeak.

Choose the 8, 15, 45 key.
Select ABC + Pages.

ABC with Page Links PAGE ey =

Select PAGES

On the Pages for ABC Page, you can choose a place to add a page.
You can now create a new page.

Select the Tools key and go to the Toolbox.

. Select Create Page.

. Type in a name for your new page, like "NFL football".

. Select OK.

. Leave the number of locations set on 45.

. Select Copy from an Existing Page.

. Use the More Items key at the bottom of the page until you see BLANK for ABC.
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Choose the page to copy from.
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When you choose BLANK for ABC, you see the new page you are working on.

16. Choose the key you want to start creating. You will then see options to Spell Text for
Message, Change Icon and Change Label. Continue to follow the prompts on the
screen until you complete these three options.
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Choose type of message, then create
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17. If yoyAvant to program another key, select Choose Next Key to Define.

18. Select OK, OK when you are finished.

19. Now that your new page is made, you can set it into the Pages for ABC Page.

20. On the Pages for ABC page, first select the Set-up Key, then choose a blank key.
Select Spell Text for Message.
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Select Insert Tool.

Spel |l message, Thgn select OK

SHIFT CTRL 8 | <SPACE> ||| <5PACE>

21. You see a list of all the device tools. Use the More Items key at the bottom of the page
to find Set Page.

22. Select Set Page, then choose the page you are adding, "NFL Football”.
23. Change the icon and the label on the key where you set your new page.

PAGES for ABC PAGE

CCCCC
DDDDDDD

VANTAGE/VANGUARD PASS MANUAL
16



Vantage /Vanguard™ PASS™ Program

Install the PASS Program

< Close any open applications before installing the VT/VG PASS.

Insert the PASS CD into the CD-ROM drive on your computer. From the screen that appears,
choose the Vantage-Vanguard option. You will see this box on your computer screen:

%7 getup - Yantage-¥anguard PASS * -10] x|

Welcome to the
Vantage-Vanguard PASS Setup
Wizard

Thisg will install ' antage-vanguard PASS 4.03 on your computer.

It iz recommended that you cloze all ather applications before
cantinuing.

Click Mest to continue, or Cancel to exit Setup.

MNest > I Cancel

Click on Next and follow the instructions.

If the Install process does not begin automatically on your computer, go to the drive where
you inserted the CD and click on PASS _install.html. This will open the PASS installation
options screen.

When the installation is complete, close the program and go to your computer Desktop. Open

PASS by double clicking on the icon:

VANTAGE/VANGUARD PASS MANUAL
17



About PASS

SFiles created in PASS can be used with both the Vantage and Vanguard 1l communication
devices. For ease of reference, we will simply use "Vantage" in this manual.

S Important Note! MTI files created with this new PASS software cannot be loaded into

devices using an older version of software. MTI files created with older versions of software can
be loaded into the new PASS software.

For example: If you have an older device and want to make vocabulary changes using this new
PASS software on your computer, the new vocabulary will not load back into your device. If
you create vocabulary using this new PASS software, you cannot share it with people who are
using an older version of software on their devices.

PASS contains a Vantage Emulator. This means that when you open PASS, you will see a copy
of the Vantage screen on your computer monitor that looks and runs almost exactly like the PRC
Vantage device. The biggest difference between PASS and the Vantage is that the Computer
Pages, Computer Activities, IR and some of the Selection Techniques will not work from the
emulator.

PASS also offers some special features that you will learn about in the following pages.

=¥| examples in these instructions use the default VVantage vocabulary, Unity® 45 2-hit. This
is already loaded into User Area 2.

pcs™ symbols are turned on and available for use in this emulator.

VANTAGE/VANGUARD PASS MANUAL
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& A Note about using switches: You can emulate using a single or double switch by
selecting the technique you want from the SELECTION TECHNIQUE MENU. The key/switch
assignments are below. The Joystick selection technique will not work.

These Keys: Control These Actions:
LEFT <Ctrl> Switch A SELECT
RIGHT <Ctrl> Switch A OFF/ON
LEFT <Shift> Switch B OFF/ON
RIGHT <Shift> Switch B SELECT

& Note: If you are using the <Shift> keys, you may see a message on your computer screen
about "Sticky Keys" being turned on. Read the message and select whether you want to use them
or not.

<& A Note about using System Lock: You can turn System Lock On and Off in the
PASS. When System Lock is ON, if you select certain menus in the Toolbox you will see a
message that tells you that SYSTEM LOCK is On. To use the menus, go to the
MAINTENANCE MENU and turn System Lock Off.

VANTAGE/VANGUARD PASS MANUAL
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About the Demo Vocabularies

The PASS comes with Unity vocabularies already loaded into User Areas. There is also a Demo
Vocabularies option that allows you to try out WordPower™ (and perhaps other vocabularies).
To find the demo vocabularies: go to the Toolbox, open the CHOOSE OVERLAY menu, select
Overlay Menu and then select Demo Vocabularies (You may have to select More Items to see
the DEMO Vocabularies option.). You see the WordPower™ demo vocabularies to try.

< Important Note: Loading WordPower™ erases Unity® (or any other) vocabulary
If you select the WordPower demo, all the current vocabulary in the PASS will be erased and all

six WordPower vocabularies will load. @ If you want to save the vocabulary you are currently
using, perform an MTI before loading WordPower.

WordPower contains its own Word Prediction dictionary and it is not compatible with the Unity
Word Prediction dictionary. If WordPower is loaded, Unity has to be erased. If Unity is loaded,
WordPower has to be erased.

If you select to load the WordPower demo you will see the following warning:

Erase All ]

Loading the WordPower Demo vocabulary: will
ERASE ALL stored wocabulary,

#kEn) | wWardPower vacabularies will be loaded ROk

Do wou wank to do this?

If you say "No", PASS keeps your original vocabulary and exits the erase the menu. If you say
"Yes", PASS loads the new vocabulary.

< Remember: Loading the WordPower demo replaces all other vocabulary in the device.

If you load WordPower and later want to return to using Unity, you will have to re-load the
Unity vocabulary. If you saved your memory using the MTI, you can load the saved memory
back into PASS. If you just want to load a single Area or two you can use the Choose Overly
option in the USER AREA MENU. You can also open the MAINTENANCE MENU and select
the Reset Defaults option which will return the PASS to its original defaults.
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Using PASS

Getting Acquainted

) Vi
On your computer's desktop, double-click on the PASS icon, . This opens the emulator.
Click OK on the Welcome Message. You should then see the Exploration Wizard.

U WantageVanguard Developer's Assistant - Jun 23 7005 - Area 4 - Esploration Wizard

[FRmrmmmr 9685 11:28A0  Cops Lock [
ShiFt
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Select the 45 2-Hit key.

You are now using the PASS Emulator. Notice the Menu Bar above the Text Display Screen.
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Open the Options Menu.

VANTAGE/VANGUARD PASS MANUAL
21



File Edit | COptions Tools “ocabulary  Help
& 5o to Toolbox Fo ]
ser Defined key #1 F3

ser Defined Key #2 F7

Hide Menu Bar F4

Select Go To Toolbox.

You see the Toolbox display.
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Now you are in the Toolbox and can use it the same way you would on your device. For
example, select the MODIFY ACTIVITY menu. You see:

U Yantage Vanguard Deweloper's Assistant - Jun B 2005 - Area 2 - Unily 45 Tea Hit

Fin (1 Optioes Took Vocabudry Help

‘Chooae activity then modify as needed. ]
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You can modify any activity you want to, the same way you would on your device.
Select Cancel to return to the Toolbox.

VANTAGE/VANGUARD PASS MANUAL
22



Using the Screen Capture Option in the Tools Menu

Perhaps you want to create a new activity in order to teach people how to do it. You would like
to take a screen picture of every step you make in the process. Then you would like to print the
pictures and use them as handouts. You might even like to e-mail the pictures to someone.

Go to the Toolbox.

Activate the CREATE ACTIVITY Menu.

Spell the name for your Activity.

Open the Tools menu in the menu bar at the top of Text Display Area.

File Edit ©ptions | Tools Yacabulary Help

[

Screen Capture Ckrl+G

Ernail L4
o ko SpringBoard Ckrl+ShifE+5

Notice that the second option in the menu is Screen Capture. This allows you to take a picture
of the screen you are working on.

Select Screen Capture.

The default graphics program on your computer will open up. This is usually MS Paint®

The emulator will take the screen shot and the graphics program will display it on your
computer. Open the File menu on the graphics program and select Save As. Name and save the

picture to a file or folder where you will be able to find it again. & To select a different
graphics program, see the next page, Set Preferences from the File Menu.

Whether you select Save As or not, the graphic will be saved automatically in the PASS folder
that was placed on your computer when you installed the program.

Sif you can't remember where the PASS folder is, open your Start menu , select Find, select
Files or Folders, type in PASS and click on Find Now.

The picture will be placed in the BMP folder and named "SCREENDUMP.BMP". Each screen
capture you take will overwrite the picture that was last placed in the BMP folder, so there will

never be more than one picture in this folder. SWwe highly recommend that you select Save
As in the graphics program and name and save the picture to a file or folder of your choice so
you will remember where it is.

You can continue to capture and save each screen in the CREATE ACTIVITY process. Once the
pictures are named and saved into a folder on your computer, you can print them; you can open
a word processing document and paste or insert the pictures into the document and print the
document; you can insert or attach them to an e-mail using the E-Mail Screen Capture option;
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you can use them in a PowerPoint® presentation. In short, you can do anything with them that
you can do with graphics on your computer.

Set Preferences in the File Menu

|File Edit  Options  Tools  Wocabulary  Help

Mew. .. Zkrl+M
Qpen... CErH
SEVE, Chrl+5

Save and Dpen.. .

Preferences Sek Graphics Program. ..
Set Word Processar. ..

Exit

Turn Sequence Choices OFf

Turn “welcome" Message OFf

Turn Yocabulary Qukput Labels OFF
Turn Wocabulary Instruckions On

You can select a graphics program and a word processing program of your choice in this menu
option. If you do not set a preference, PASS will use WordPad® and MS Paint® as the default
programs. If you want more features than WordPad or MS Paint provide, then use the Set
Graphics Program and Set Word Processor options to set the programs you want to use. Once
you set a preference, all graphics and documents will be saved in those programs unless you
return to Preferences and select different ones.

Options:

e Turn Sequence Choices Off: this applies to the Write with Icons option and allows PASS
to choose the most-likely sequence for you rather than display all the choices.

e The Welcome Message can be turned On or Off in this menu. When this is turned On, you
will see a screen that contains a few quick tips about often-used PASS options. You can also
see this screen by opening the Help menu and selecting Welcome Message.

e Vocabulary Output Labels Off: this 'Unclutters” the display when you are using Look Up
Vocabulary Location; turns off all the explanatory text attached to icon locations.

e Vocabulary Instruction Off: removes Unity-specific information at the top of the screen;
this option applies to all vocabulary displays
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Using the MTI Options in the Tools Menu
& Make sure your e-mail program has the MAPI server enabled.

=] mportant Note! MTI files created with this new PASS software cannot be loaded into
devices using an older version of software. MTI files created with older versions of software can
be loaded into the new PASS software.

For example: If you have an older device and want to make vocabulary changes using this new
PASS software on your computer, the new vocabulary will not load back into your device. If
you create vocabulary using this new PASS software, you cannot share it with people who are
using an older version of software on their devices.

If versions won't match, this warning will appear:

CALTION: MTI version mis-match,
Mocabulary changes made using PASS software will not transfer to the device that created this MTIL

You can still examine older MT] files and explore vocabulary but you cannot make MTI
changes.

Creating an MTI file

PASS allows you to do a Memory Transfer while you are in the emulator. This means you can
create a Page or Activity and save it as an MTI file in your computer. Or you can save a whole
User Area or the complete emulator vocabulary as an MTI file on your computer. Once you
have created the MTI file you can e-mail it to someone if you would like to.

For example, let's say you created a Page. You want to save it as an MTI file and then e-mail it
to someone so they can download it to their computer and load it into a device or into their PASS
emulator.

Once you have created the Page, open the Tools menu in the menu bar at the top of the
emulator's Text Display Area.

Select Memory Transfer (MTI)
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File Edit ©Options | Tools Yocabulary  Help

Memory Transfer (MTL

Screen Caphure Chrl+3
Email r
2o ko SpringBoard Ckrl+3hift+5

You see the TRANSFER MEMORY MENU on your screen.
Select Save A Page.

Select the Page you want to save.

You will see a screen similar to this one:

Select an MTI File 2| x|

Save in: Iﬁ My Documents j gl

| brochure and letter
|1 Clerk of Session
1 Long Range Flan
"1 MISC Dacs

|1 My Pictures

File name: I“.mti ’

Save az lupe; IMTI Files [#.mt] i

[ Open as read-only

Type in a name for your page. Make sure the name ends with .mti (dotmti).
Select Save.
A yellow box will appear telling you the transfer is complete. Click OK.

Sending an MTI via E-mail

Open the Tools menu at the top of the Text Display Area.
Select E-mail.
Select E-Mail - Memory Transfer (MTI)

File Edit ©Options | Tools Yocabulary  Help

Memory Transfer (MTL
Screen Caphure Chrl+3

Screen Capkure File (BMPY. ..
2o ko SpringBoard Ckrl+3hift+5 = (BMF)

Wocabulary File (RTFD. ..

Depending on where you saved the file, you will see something similar to this:
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Loak ir; I@ My Documents j gl

1 brochure and letter
1 Clerk of Session

_ 1 Long Range Flan
_1MISC Docs
— ,

Dy

j Cancel

Filez of type:  [MTI files [*.mh)

[ Open az read-only

Select the File

PASS shows you the last file or folder where you saved an MTI file. Click on the name of the
file you want to e-mail and select Open. If you want to send an MTI file that was stored in a
different folder, click on the arrow in the Look In box and find the folder that contains the MTI
file you want to send. Highlight the file and then select Open.

Send the E-mail

When you have selected Open, a new message from your e-mail program will appear on your
screen. The MTI file will be attached to the e-mail. All you have to do is type in an address and
any message you want to add and then send the e-mail.

< You can e-mail a vocabulary document (i.e., a Vocabulary Display that you have saved as a
document) or a screen capture in exactly the same way as you e-mail an MTI file.

If you Receive an MTI File as an E-mail Attachment:

Open PASS if it is not already open.

Open the Tools menu in the menu bar at the top of the screen.

Select Memory Transfer (MTI).

Find the MT] file you received and click on it. The file should be in your e-mail Attachments
folder.

Click OK in the yellow box when the transfer is complete.

You can load any MTI file into your emulator as long as the file is on your computer. For
example, if you want to load a User Area from a Vantage into a User Area in your emulator, you
must first perform a regular device-to-computer MTI. Once the Area is saved as an MTI file on
your computer you can use the Memory Transfer (MTI) option in the Tools menu and transfer
the Area into your emulator.
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If you want to load a User Area from your emulator into a User Area in a device, first you have
to save the emulator User Area as an MT] file using the Memory Transfer (MT]I) option in the
emulator's Tools menu. Once the Area is saved, use the regular computer-to-device MTI process
to load the Area in the device.

Other Tools Menu Options

Go to Pathfinder or SpringBoard

If you have the PASS software for Pathfinder and/or SpringBoard installed on your computer,
this option will open it without your having to go to your desktop to click on the icon. This
allows you to move quickly from your device to the other device emulators for programming.

Browse Icons

If you select this option, you see the Icon Category folders on your display screen. You can now
browse through the folders. You cannot select icons from this option, but you can see what icons
are available and find out where they are stored.
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Now You Can...

e Save a picture of the Vantage display
e Save pictures of the steps used to create a Page or Activity
e Save a picture of a User Area Overlay

Use these pictures as teaching tools

Save the pictures in a graphics program and print a picture or e-mail it
Insert the pictures into a document and save them

Create a specialized vocabulary for a client in one of the PASS User Areas

If PASS software versions are compatible you can:

e Turn specialized Vocabulary into an MTI file and download it into the client's VVantage or
Vanguard.

e E-mail an MTI file to a colleague who can then download it into a device or into their PASS
emulator.
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Using the VVocabulary Display Options

The Vocabulary menu has a VVocabulary Display option that allows you to do a number of
things with the vocabularies in the emulator. You can do vocabulary sorts for Core vocabulary,
Activities, Pages, etc. You can see where icons and sequences are stored, what the rationales are
for different icons, etc. You can add your own comments to rationales. You can find specific
phrases. You can even type in text and see the icons that represent your text.

< When you are using options in the Vocabulary Display menu, you will see a display of the

vocabulary that is in the current User Area of your emulator. You can switch User Areas in the
emulator to see different vocabularies.

For example:
Double click on the PASS icon on your desktop to open the program, if it is not already open.
(If PASS did not open up in Minspeak, select the Go To Minspeak key.)

Now you should see the overlay in the current User Area. For this example, we are going to use
the 45 2-Hit overlay. Make sure this is the overlay you are using. To check this, select the
Options menu, then select Go to Toolbox. Activate the CHOOSE OVERLAY menu in the
Toolbox. If the text in the Text Display Area does not say Unity 45 2-Hit, activate Switch User
Area and select the Unity 45 2-Hit User Area. Click OK. Activate Go To Minspeak.

Open the Vocabulary menu at the top of the Text Display Area and then open Vocabulary
Display Options.

File Edit Options Tools | Yocabulary  Help

Reeturm bo Emulator Fz

Yocabulary Display Options Core Key Assignments

Core Wocabulary (Sequences)  #
[Crenarnic Activikies k
Specific Ackivity, .,

Specific Page. ..

Play Wiah File, ..

Loak up Wocabulary Location, .
Write with Icons

All of the new options allow you to view vocabulary in different ways.

Select the Core Key Assignments option.
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The Core Key Assignments Option

W vantage/¥anguard PASS, Aug 25 2005 - Area 2 - Unity 45 Two Hit

B ] 3
File Edic Options Tools VYocabulary Help
* Hold the right mouse button down over a key to view key details. =
* Double-click on a key to edit rationale information.
* Scroll down[using the scroll bar] to view details text.
* Go to File->Save and Open to save this information for editing or printing. |
[Read Only]
Unity 45 Two Hit - Core Key Assignment Information

< 9
word

bk

lcon Name:UNITY

=)

You now see a copy of the current User Area vocabulary (Unity 45 2-hit).

& Notice the background color of the display (on your screen) and the directions at the top of
the page. Both of these are indicators that you are in a Read-Only display. This means that
basically the only things you can do are what the directions at the top of the page tell you. The

Edit menu is not available for use.

All Read-Only displays (there are 3) have the pink background and the same directions at the
top of the display. All other Vocabulary Displays have a cream colored background and the Edit

Menu is active.

Read-Only Vocabulary Display Directions

-

ile Edit Options Tools ‘ocabulary  Help

Double-click on a key to edit rationale information.
Scroll down[using the scroll bar] to view details text.

* » % *1

Hold the right mouse button down over a key to view key details.

Go to File->Save and Open to save this information for editing or printing.

If you place your mouse over a key and hold down the right mouse button, you will see details

about the key. For example, right click on the MOUNTAIN icon.
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You will see, among other things, the icon name, its location on the overlay and the file name
under which you can find that exact icon.
The instructions that you see on the screen can be turned Off in the File/Preferences Menu.

If you want to add a rationale to the icon, double click on the key you want. For example,
double click on the MOUNTAIN icon.

This box appears over the display.

=101 x|

Y yantage,/¥anguard |
1 File Edt Options Taol

| »

[l Icon Rationale x||a key to view key details.

1 nformation.

. lcon Name:MOUNTAIN ¥ details text.
Icon File:MORNG_M3.P34 information for editing or printing. ||
Location:(R4C7)

Rationale:

GET up in the MORNING.

The mountains could be NEAR or FAR
away.

You can fall from the tall mountain.
Activity Row - Nature

a
&7

% |53

| )
. ’TI Cancel | =é
i |5 |

‘ CLEAR

© Icon Name:UNITY hd

Type in the rationale.
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Icon Rationale |

lcon Name:MOUNTAIN
Icon File:MOBRNG_M3.P84
Location:[RACT]
Rationale:

Mountains are big.

GET up in the MORNING.

The mountains could be NEAR or FAR
away.

“‘ou can fall from the tall mountain.
Activity How - Nature

Save Cancel

"Mountains are big" has been added to the rationale. If you select OK, the program will save the
edited rationale. It will remain a part of the MOUNTAIN icon's rationale unless you bring up
the box again and delete your addition.

If you decide you don't want the rationale, select Cancel before you select Save. The program
will return to the default details.

& This is the only Read-Only Vocabulary Display where you can edit a rationale on-screen.

If you scroll down the vocabulary display, you will see the same detail information printed out as
text.
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% vantage,/¥anguard PASS, Aug 25 2005 - Area 2 - Unity 45 Two Hit I ] 4|

File Edit Options Tools Yocabulary Help

lcon Name:UNITY
Icon or Tool?2:ICON
Location:[R2C1)
Icon File:UNITY.PRC
YWAY File: [null)

Icon Name:PHONE

Icon or ToolZ:ICON

Rationale:¥ou CALL on the phone.
THUMBS UP means something is GOOD.
The phone is also a SMALL APPLIANCE.
Activity Row - Small Appliances.

DH - Communication Aids

Verb endings

Location:(R2C2)
Icon File:PHONE_M1.PRC
WAV File: [null]

lcon Name:POSS
Icon or Tool?2:ICON |

Save your Vocabulary Information
You can save this information to use later or to send to someone.

Open the File menu at the top of the screen.

To save this file, click on Save.

Select a place to save the file and a name for the file. For this example, you might save it to your
desktop and name it "Core Keys Vocab", or something similar.

The program will save the file as a word processing document (.rtf).

Go back to the File menu and select Open.

Go to where you just saved the file and select the file..

Click on Open.

The file opens up as a word processing document. You can now make any changes you want
and/or e-mail the document to someone, print it out, etc.

You can also select Save and Open from the File Menu. This will save your file and
immediately open it as a word processing document for you to work on. As with the Save
command, you will have to tell the program where to save the file and you will have to give it a
name before it will be saved.

S Printing Tip: Before you print any vocabulary file or overlay that you saved as a

document, we recommend that you set your printer's "paper" option to Landscape instead of
Portrait.
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To Return to the Emulator

When you have opened the Vocabulary Display menu and are working in or looking at one of
the options, you are not in the emulator. To return to the emulator and check something out, you
must open the Vocabulary menu and select the Return to Emulator option. You are now in the
emulator and can use it as you normally would.

File Edit Options Tools | Yocabulary Help

Return ko Emulatar

Yocabulary Display Cptions r

To Return to Vocabulary Display

File Edit Options Tools | Yocabulary  Help

Go ko Wocabulary Display  F2

Yocabulary Display Options »

If you went from a vocabulary display to your emulator and you want to return to the VVocabulary
Display you were viewing/working on, open the Vocabulary menu and select Go To
Vocabulary Display. You will see the vocabulary display you were using.

You must use these two options any time you want to switch from a vocabulary display to the
emulator or back.

A vocabulary display must be open in order to switch between a display and the emulator.

QKeyboard Shortcut: Use the F2 key on your keyboard to toggle between vocabulary and
emulator displays.
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Viewing Core Vocabulary (Sequences)

File Edit Options Tools | Yocabulary Help

|
ao ko Vocabulary Display Fz2 |

Yocabulary Display Options Core Key Assignments I

Core Yocabulary (Sequences) Skarts with. ..

Crymamic Activities Ends with. ..
Specific Ackivity, .. Conkains. ..
Specific Page...

Elay ol File, ..

Loak up Yacabulary Locatian, ..
‘Write with Icons

You might like to know if an icon is used in any sequences in a particular vocabulary.

Open the Vocabulary Display Options menu.

Select Core Vocabulary (Sequences).

Select whether you want to find sequences that Starts with, Ends with or Contains a particular
icon.

For example, you might want to know if the VERB icon is used as an ending icon in any
sequences in the current vocabulary. You would select the Ends with option.

Core lcons =
Select a Core lcon

[ o |
= el |

Cancel

When you select the Core Vocabulary (Sequences) Ends with option you will see this box.
You can select any icon in the vocabulary as the Ends with icon. For this example, scroll down
and select the VERB (Mr. Action Man) icon. Then select OK.
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& You can use keyboard shortcuts to navigate through the icons. e.g. Tab, OK, Cancel, and the
Up and Down arrows; otherwise, just use the scroll bar.

QVocabuIary Display is changing Box: When you change from one VVocabulary Display
option to another one you will see the following box:
Save Document |
Yocabulary Dizplay is changing.

Do you want to zave the previous Yocabulan Display
az a ‘Wword Proceszsor document?

Mo Cancel |

If you want to save the earlier display, select YES. Select where you want to save the file, then
click Save. The emulator will then go to the new Vocabulary Display you selected.

If you don't care about saving the display, select NO. You will then see the new Vocabulary
Display you selected.

‘,,{ ¥Yantage,/Yanguard PASS, Aug 30 2005 - Area 2 - Unity 45 Two Hit
File Edit Options Tools Wocabulary Help
argue =
<_:
[R5CT) [R2C4] Embellishes...
drink
—J(Rsce) (M) R2c4) Embellishes...\ )
turn
G C?E;D
(R5C8) \ 4 (A5C8)
mix
[RBCY) Sleep [R2C4] Embellishes...
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When you selected Ends with: VERB, the program produced this screen. You can see where
each sequence is stored and how it is stored. If you want to copy a sequence and use it in a
custom vocabulary, just save the document and print it out. With sequences ending in the VERB
icon you might want to check on grammatical endings. You can look at a sequence in this
display then go to the emulator, activate the sequence and check how it works. Then return to
the Vocabulary Display.

& A Note About Embellished Icons: In the sequences above, the final icon in each sequence
has been embellished, or changed, in some way. In these cases the icon that has been changed is
the VERB icon. In the first example, DRINK DRINK, the VERB icon was changed to the
DRINK icon. In the third example down, the VERB icon was changed to the MIX icon. This
screen tells you that the last icon in each sequence is VERB and that it has been embellished.
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Viewing Dynamic Activities
File Edit Options Tools | Yocabulary Help

Go ko Yocabulary Display  F2

Yorcabulary Display Options Core Key Assignments
Core Mocabulary (Sequencesy

Crynamic Ackivities Starts with. ..
Specific Ackiviky, .. Ends with. ..
Specific Page. .. Conkains. ..
Flay sy File, .

Look up Yocabulary Location, ..
Write with Icans

The next Vocabulary Display option is Dynamic Activities: Starts with, Ends with, Contains
Among other things, this allows you to discover if there is a Dynamic Activity that starts, ends or
contains any icon you are interested in. It can also be helpful if you are looking at Core
Vocabulary on the emulator and you find a Dynamic Activity that you would like to use
elsewhere. You can find how it is stored by going to the Dynamic Activity option and selecting
one of the icons from the sequence.

Core lcons E

Select a Core Icon

0K I
Cancel |

(=l

Activate OK when you have selected a Dynamic Activity.
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‘,L' Yantage/¥anguard Developer's Assistant M= E3
File Edit Options Tools “ocabulary Help
Dynamic Activities Starting With PHONE =

(R1C2) speak ) (R1c4) Embellishes... Activity SENT BLD2 ‘SERT B

0

2 SENTEI

(R1C2) (R1C7) Embellishes... Activity SENTBLD1

ord

SENT BLD4

(R1C2) Activity SENT BLDA

ord

SENTELD12

(R1C2) Activity SENTBLD12

ord -

SENT BLD3

REMEMBER

(R1C2) Activity SENT BLD3

JEEREER

i

#
m [R3C5] Embellishes...
(2 AN

—

In the example above, PHONE is the Starts with icon. You can easily see what Dynamic
Activities start with PHONE, their sequences, and which Activity is activated. As usual, you
can edit in the display, save it and print it later.
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Viewing Specific Activity

Using the previous Dynamic Activity example, let's say that you found out that PHONE +VERB
activates the Sentence Builder 4 activity. Now you would like to know about that activity.

Open the Vocabulary Display menu and choose Specific Activity.

File Edit Options Tu:u:ulsl'-.-'u:u:al:uulary Help

Go ko Wocabulary Display  F2 |

Yocabulary Display COptions Core Key Assignments
Core Yocabulary (Sequences)  k
Dwnamic Ackivities g

Specific Ackivity. .,

Specific Page. ..

Blay wiah File. ..

Loak up Yacabulary Laocation, ..
Write with Icons

Now, select the activity you want. In this case, scroll down to WORD SENT BLD4. Click OK.

Select an activity 0K I
SENT BLD 4|
Cancel

A
WOfd SENT BLD1

SENT BLD1

WOfd SENT BLD2

SENT BLDZ

Word SENT BLD3

SENT BLD3

WOTUEEET

SENT BLD4

Word SENT BLDS

SENT BLDS x|
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‘1’ ¥Yantage,/¥Yanguard PASS, Aug 25 2005 - Area 2 - Unity 45 Two Hit

=10l
File Edic Options Tools Yocabulary Help
* Hold the right mouse button down over a key to view key details.

Scroll down[using the scroll bar) to view details text. m
Go to File->Save and Open to save this information for editing or printing.

[Read Only]

*

*

Unity 45 Two Hit - Activity SENT BLD4 Definition

word
SENT BLD4 )| (HIDDEN]
|7 Jeo|Ralthel it @] [

Key Label: .
lcon File: none
Row 1; Key 1
WAV File: [null]

<DELETE-CHARACTER><SERIAL-MARKER>Ibackspace.<TEXT-MARKER>. <CTRL><SPEAK-SENTENCE><SHIFT>
<PROMPT-MARKER>smart period

=]

You see a display of all the keys in the Activity. As you scroll down the display, you will also
see all the links to this activity. If you scroll down a bit, you'll see that the PHONE+VERB
sequence is a Dynamic Activity link to the SENT BLD4 activity.

DA right click on a key will also show you that key's details.

W vantage/¥anguard PASS, Aug 25 2005 - Area 2 - Unity 45 Two Hit

T 10X
File Edit Options Tools Wocabulary  Help

Activity Name: SENT BLDA
Key Label: BACK

Icon File: RETURNZ.PRC
Row 1; Key 9

WAV File: [null] J
<GOTO-MINSPEAK><PROMPT-MARKER> go back

Links to Activity SENT BLDA

| (R2C7) Embellishes...

Dynamic Activity
ﬂz“ ) 1
ot — |
[R2C3) print -:[RZCT] Embellishes...

Activity SENT BLD4

Dynamic Activi

Al
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The Dynamic Activity option and the Selected Activity option can help make it easy to find and
modify specific activities on your emulator.

This is a Read-Only Display so you cannot edit it as you look at it. However, you can save the
display in a word processing document, edit it if you wish and print it out.

Viewing Specific Page
This option allows you see all the items associated with a Page.
Click on Specific page

File Edit Options Tools | vocabulary Help

Return bo Ernulator Fz

Yocabulary Display COptions Core Key Assignments
Core Yocabulary (Sequences)  k
Dwnamic Ackivities g
Specific Ackivity. .,

Specific Page. ..
Blay wiah File. ..
Loak up Yacabulary Laocation, ..
Write with Icons

Select a page 0K I
COLORS
Cancel |
111} =

01
45QWERTY
ABC
ACADEMIC
AEIOU
BBEAR
BODY
BOOKS
CANADA

cD

CLOCK
|COLORS
COMPUTER
COOKING
COSMETIC
DATE
DRAWING
DRINKS
EZPHONE
FAMILY
FASTFOOD
FOODS
FREQUENCY
HEALTH
HIDESEEK
HOLIDAY
ISPY

JOKES
KEYPAD |

Select a Page to view.
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W Yantage/Vanguard Developer's Assistant
File Edit Option: Tool: “ocabulary Help
Page Definition for COLORS

Hold the right mouse button down over a key to view key details.
Scroll down[using the scroll bar] to view details text.
Go to File->Save and Open to save a copy of this page for editing and printing.

*
*

5

I‘IINSPERI(

DELETE I

El

When you choose the Selected Page option, you must pick a Page to be displayed. For this
example, we selected the COLORS Page. You see all the keys that are associated with the

selected Page, their assignments, etc. The display will also tell you if there are any links
associated with the Page.

You can even select to display the PAGES Page. This gives you a list of all the individual pages
in a vocabulary and how to get to them.

This is a Read-Only Display so you cannot edit it as you look at it. However, you can save the
display in a word processing document, edit it if you wish and print it out.

DA right-click on a key will also show you that key's details.
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Look Up Vocabulary Location

File Edit Options Tools | Yocabulary  Help
Go bo Wacabulary Display.  F2

vocabulary Display Options Core Key Assignments

Core Yocabulary (Sequences)  #
Cewnarmic Activikies k
Specific Ackivity. ..

Specific Page. ..

Play Wiah File, ..

Look up Yocabulary Location. ..

Write with Icons

Find where particular text is used in the Area.

Find i E |

Find what; Ieat

¥ tatch whole ward only Cancel

[ atch case

Type in the text you want to find. Here, we are searching for the word, "eat".

Options:

e Match whole word only: if you select Find Next with "eat™ as the example above, you will
be presented with all the words that have "eat™ in them, e.g., beat, sweat, heat, etc. If you
want to see only the word "eat", select Match whole word only.

e Match Case: If you are looking for a word where one or more letters are capitalized, select
Match Case so the software will look for the exact word.
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‘,LI ¥Yantage/¥anguard PASS, Aug 30 2005 - Area 2 - Unity 45 Two Hit
File Edit Options Tools Wocabulary Help
* Go to File->Save and Open to save this information for printing. =

eat found in the following Yocabulary Locations - Unity 45 Two Hit

Core Seq ]
— lirscay Bat  lr2cq)

eat

Page WHATDO

(R5C4)

Activity

by v

WORD PLAiKey 8) Activity Key 23t __[A5C4) Page Key
<SET-PAGE[WORDPLAY]><PROMPT-MARKER>word play page eat -

el |29 | :

In the above example we wanted to find where the "eat™" was used. PASS has given us a display
of all the places we can find this phrase.

Page IR CAR

PASS will show up to 40 results for the text you entered. If you see a message box that says
there are more than 40 examples, try being more specific when entering the search text. Use
different combinations checking and unchecking the two option boxes.

You can also narrow a search by adding a space before, after, or before and after a single word.
However, this may miss some of the places where a word is used. Play with this option to
discover how it might best serve your needs. If you create your own overlay, you could use a
space in different places to find partial words or misspelled words.
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For another example, go to the Look Up Vocabulary Location option. Type "go to™ as the
phrase. You see:

‘,L' Yantage/¥anguard Developer's Assistant
File Edit Options Tool: “ocabulary Help

| [ x|

o
Core Seq e

[R3C2] Page Key Page Key

<CLEAR-DISPLAY>I go to school at

Page PAGES

I go to school at
Page SELF

| |L|_v‘

Notice that every instance in which the phrase "go to" is used is displayed, beginning with Core
vocabulary.
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Play WAV File

File Edit Options Tools | Yacabulary Help

R.eturn to Ernulator Fz
Yocabulary Display Options Core key Assignments
- (Corevocabulary (Sequences) B
Dwnarnic Activities L4

Specific Ackivity, .,
Specific Page. ..

Play \Wal File. ..

Look up YWocabulary Location, .,
Write with Icons

Play WAV File will be active if any of the vocabulary you have chosen to display has recorded
messages. For example, if you select to display Core Key Assignments and any of the core
vocabulary has WAV files attached to it, you will be able open the Play WAV File option. If
the displayed vocabulary has any WAV files and you select Play WAV File, you will see a box

similar to the one below. :>Play WAV File will not work with Dynamic Activities or Write
with Icons.

x|

Available WAY Files ]
[a0A0DDD.WAY yes

ADADDDO.WAY yes ﬂl
ADADDDT . WAY thank you

ADADDOG.WAY why

ADADDDZ WAY no D | .l

Play Stop
Options:

e You can choose Play to play the WAV file.

e You can choose Stop to stop playing the file.

e You can choose Save As and save the WAV file on your computer with a recognizable
name. You can then import it for a vocabulary message if you want.
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Write with Icons

File Edit Options Tu:u:ulsl'-.-'u:u:al:uulary Help

Go ko Yocabulary Display  F2

Yocabulary Display Options Core Key Assignments
Core Yocabulary (Sequences)  k
Dwnamic Ackivities g
Specific Ackivity. .,
Specific Page. ..
Blay wiah File. ..
Loak up Yacabulary Laocation, ..
wtrite with Icons

The Write with Icons option allows you to type text, word by word, and see it displayed as
icons. Words that are in the Core Vocabulary and Dynamic Activities of the current User Area
in your emulator will be displayed. You must type the word then add a space, tab, return or
punctuation after it. If you type a word and nothing happens, either you forgot to add a space,
etc., at the end of the word, or that word is not available in the current vocabulary.

For example:
Select the Write with Icons option.
You see the Options Box.

Write with Icons 5'

Icon Size [Inches - ratio):

0.81in-1x = Cancel |

—Appearance

prey

3 [¢ Instructions on page
¥ lcon on Key Background

[+ Icons Only [no typed words)

— Functionality
¥ Core Only [NO Activity keys]

¥ lcon Sequence choices!

[+ Automatic phrase handling

You may set the options however you want to.
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Appearance Options:

Instructions on Page: When this is checked, you will see instructions on the screen for using
Write With Icons. If it is unchecked, the instructions will not be visible. (This is also a setting in
File: Preferences.)

Icon on Key Background: If this is selected you see the icons as they appear on keys: ﬁ"| =
> Note: If you select this option, you may find that it causes some visual confusion. It also
consumes a lot of ink if you are printing the screen.

Icons Only (no typed words): If this is selected, when you type words, only those words that are
not contained in sequences will be visible on your screen. @Note: Unless you know your
vocabulary extremely well, you might want to leave this box unchecked until you get used to
Write With Icons.

Functionality Options

Core Only (NO Activity keys): If this is checked you will see only Core Vocabulary icons or
sequences. Any Activities where the word is used will not be shown.

Icon Sequence Choices: If this is selected, when you type a word, a box will pop up containing
all the sequences where the word you typed is used. (This is also a setting in File: Preferences.)

Automatic Phrase Handling: When this is checked, Write With Icons automatically figures
out if a group of words is stored under a sequence and then produces that sequence for you. If
this is unchecked, Write With Icons produces sequences for each separate word you type. When
this is On, end each phrase with a punctuation mark so PASS knows you have ended the phrase.

< Note: If Automatic Phrase Handling is Off, you can force Write With Icons to produce a
whole phrase by using the F6, F7 and the SPACE keys. See the next page.

Select OK when you have finished choosing your options. You are ready to Write With Icons.

An Example of Write With Icons

You see a blank Write With Icons page.

We are using the 45-2-hit vocabulary.

Type the word, "I" and add a space.

You see a box with all the possible "I" sequences. The most likely sequence is highlighted at the
top of the box. Select the sequence you want to use.
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Type the word "want" and add a space.

=

I want

You see the sequences under which I, and WANT are stored. Since these are Core vocabulary
words, they are often used in Dynamic Activities as "building block™ words. In this example you
saw message boxes that gave you various choices that are available in the Activity Row after the
sequence is selected. You can add an ending or select No Activity Key to stay with just the Core
words.

< Since Automatic Phrase Handling is ON, if individual words are stored as phrases, PASS will
display the phrases.

Now type "to" and add a space. Select the sequence you want.

Type "eat". Select the sequence you want. Now you know how "l want to eat" is stored.

Finding Phrases using the F6 and F7 Keys

You can also find sequences for phrases by using the F6 and F7 keys on your keyboard. You can
use F6 and F7 whether Automatic Phrase Handling is On or Off.

Below is an example of using F6 and F7 to force phrase groupings when Automatic Phrase
Handling is ON.

Our example sentence is "What do you do?"

Type the word “What” and see:

B
WO?I'd 5

What I b ]

Now type “do” and see this:

AJ‘
Sal L2k ;
E
What L do ) da )

Type “you”.
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wia| D o |43

What what do you do your

Type “do”, and ---you see:

L

BOOKS

What do you do

Your earlier sequences have disappeared! PASS is telling you that the whole "What do you do?"
sentence is stored on a Page, which is nice but not what you want to teach. You want to teach
the basic sequences.

Now you use F6 and F7 (even though Automatic Phrase Handling is turned ON) to force PASS
to give you the basic sequences.

Type What, space, F6do space youF7, space do space or punctuation mark.

-2 .

< You can also use F6 and F7 with a single word. This will prevent the word from becoming
part of a phrase or group of words.

Use Punctuation to End Phrases and/or Sentences

With Automatic Phrase-Handling, punctuation at the end of a phrase or sentence tells PASS
when you have finished with one phrase and are moving on to another one.

For example, if you type "What, space, F6do youF7, space do", with no ending punctuation and
then start another sentence that begins with, "You", PASS is likely to think that the last word of
the previous sentence and the first word of the new sentence make up a phrase that is stored
under a sequence.

This is what you would see which is probably not what you want.

) B
What what do you do_you? do ¥ou do you?
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To prevent two distinct sentences or phrases from “running together”, type a punctuation
character (in this case a ?) at the end of phrases or sentences so PASS knows they are finished.

- el 113
? H 3 .
word :Il £ 5 5
What J__what J do you | _doyour | do? ! do ) You )} ou )

Change your Options without Losing your Work

If you are in Write With Icons and would like to see your icons displayed differently, without
losing the work you have already done, open the Vocabulary Display Menu or press F11 on
your keyboard.

Select Write With Icons.

The Options box pops up.

Change to the options you want to use.

Select OK.

A message asks if you want to save your work.

Select Cancel.

You are returned to Write With Icons and your work is still there.
Now you can type words and the new settings will be used.

Plurals

If the vocabulary has the PLURAL tool stored under a core sequence, Write with Icons can
generate the plural of a word and display the whole sequence.

For example:

Type "calf".

Press the F8 key.

Type a space (or punctuation or <RETURN>).

VANTAGE/VANGUARD PASS MANUAL
53



Now You Can...

e See details of a Vocabulary (use any option in VVocabulary menu)

e Teach all the associations that start with, contain or end with a specific icon (Core
Vocabulary (Sequences)

e Save arecord of all the Dynamic Activities that start with, end with or contain a specific icon
in its sequence (Dynamic Activities )

e Print a specific Activity, including its details, for training; make copies for the staff who
work with the client (Specific Activity)

e Print a specific Page, including its details, for training; make copies for the staff who work
with the client. (Specific Page)

e Discover where a particular text item (word, phrase, sentence and/or character string) is
stored (Look Up Vocabulary Location)

e See icon sequences that match the words you are typing (Write with Icons)

3 Remember: you can also take pictures of the emulator displays, save the displays as
word processing documents, and e-mail pictures and documents.
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Addendum: Importing Sound (WAV, MP3, WMA) Files

PASS now allows you to import .wav files and store them as recorded messages.

Any Toolbox Menu that allows you to store recorded messages now has a button labeled Import
Sound File that becomes active when you select Recorded Message. Instead of recording a
message you can find a sound file that you have saved on your computer or have stored on a
USB drive and store it as the recorded message.

< You cannot use sound files for prompts. /

Choose location to modify, then create
or change message. Select OK when

L)) e

r—Tupe of Message —
Previous More DECtalk
Items Items a Recorded

Import Text to Display

Caps Lock I
Shift |

Clear Key
Contents

Add New
ADELETE-CHARACTERY ASERTAL-MARKERP <backspace . {ATEXT-MARKERK . ou
ASPEAK—SENTENCEN 4SHIFTP 4CHOOSE-ACTIVITYF 4PROMPT-MARKERP sm. . .

File

Sound ‘

. Delete
Listen to Spell Text
Record Message “‘ Recording “‘ to Display “ Cuazanf

Change Position
Change Change Change
Icon Label cl{7y h # Help Cancel
olor

For example, in the picture above:

b

We are in the MODIFY ACTIVITY Menu and have selected the Modify Item Within Activity
option. This is a storing screen. We have activated the Recorded option.

Activate the Import Sound File option.

Search for the file, folder or drive where you have sound files stored.
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EHChimes. way @ Tada wavw
B Chard way @ The Microzoft S ound. war
2 Ding way

Loak jr: |EJ tMedia j ﬁl

Logoff waw
Hatify, way
Recycle. way
Start waw

File narne: |Ehimes.wav Open

Files of twpe: IW,&-.U Files [* wav)] j Cancel |

[ Open az read-only

Select the file you want to use and activate Open.

You don't see anything happen, but the file will be used as your Recorded Message. Activate
Listen to Recording to check that you got the correct file. When you have finished with this
screen, save your changes by activating OK to exit. If you decide not to save any changes,
activate Cancel instead of OK.

Sif you have a previously recorded message assigned to a key and you import a sound file, the
sound file will replace the recorded message. Any macros assigned to the key will remain with
the key.
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Addendum: Importing Icons

Go to the Toolbox and open the TRANSFER MEMORY MENU.

Select Import Icons

‘,L' Yantage - Yanguard PASS, Area 2 - Unity 45 Two Hit - 4.03 Mar 3 2006 = |EI|1|

File Edit Options Tools Yocabulary  Help

TRANSFER MEMORY MENU |

[* 5T, 3/2/86 1:56PH Caps Lock

Shift =
o =
"y I Speech T

——MTI Method ——

Load Entire Device Contents

——MTI Baud Rate —

Save Entire Device Contents

Load Icons from MTI File “ l | 5’6088 \

Load One User Area

Load a Page “

Save One User Area

S—8 H— N —

Save a Page “ ‘ select Save Directory “

Help | Cancel | 0K |

You see a drive or folder on your computer where graphics are stored. If the icons/graphics you
want are stored there, select them or go to the drive/folder where the icons you want are stored.
You may select one graphic, or hold down the <CTRL> key on your keyboard and click as many

graphics as you want.

The next page explains importing one icon. The following page explains importing a number of
icons at the same time.
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Choose one or more bitmap files to import i |

Lock jn: | 3 'wINNT x| & ® ¥ E-
MWW3EZ [ bwain_32 Rhododendron.bmp
Profiles CJusez Rivet Sumida,bmp
Reqistration Clweb Santa Fe Stucco.bmp
repair Blue Lace 16.bmp Soap Bubbles, bmp
SeCuriky . Coffee Bean.bmp Zapokec.bmp
ShellMew . FeatherTexk
Speech
Sun
syskem
syskbem32
Temp

A
File name: I"F'rairie Wind. brp" '"Coffee Bean.brp
Files of type: IBitmap files [*.bmp;*. jpg;*.qif]

Select an icon to import and then select Open.

W vantage - Yanguard PASS, Area 6 - 84-WordPower Demo - 4,03 Mar 3 2006 = ] 3
File Edic Options Toals Yocabulary  Help

IMPORT ICON MENU |
ﬁ;;;lm—nmmmr 3/6/86 4:88PM Capsst?:t E
) mmr—— =

‘ Rename Icon “

rHain‘rain fAspect Ra‘til:lI

—‘ — -

Help | Cancel | oK |

You see the graphic and an option to change the name. You can also change the Aspect Ratio
We suggest you leave this box set to YES. Select OK when you are ready.
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W vantage - Yanguard PASS, Area 2 - Unity 45 Two Hit - 4.03 Mar 3 2006

Fle Ed Options Tools bocabulary Help

Select Category for COMPUTE2 or Cancel for none

E“m—mmmmr 3,2/86 2:87PN Caps Lock I
Shift
"» '““'“ Cirl
Speech =

ALPHABET

ADVYERBS SORT

COMPUTER
ACCESS

CON-
TAINERS

CONJUNC-
TIONS

DESCRIP-
TIONS

DETER:
MINERS

DEVICE
TOoOoLS

GREETING
AND

INTER]

INTELLI-
TOOLS

MIN
SYMBOLS

PLACES
ND
NATURE

PREPOSI-

TIONS QUESTION

|

TECH-

SCHOOL NOLOGY

=]~
| ==
| =)=
-]

=]
k4
m

¥ERBS WEATHER WORDS

|
|
|

Previous
Items

|
=)=
=]
=]
) = ) =)

|
|

You see the Icon Category Menu. Your device automatically places the graphic in an
IMPORTS folder (not visible during this operation). If you want the graphic to be available in
another category, select the Category you want. If you just want to keep the graphic available in

the IMPORTS folder, select Cancel to exit the Category Menu.

You return to the TRANSFER MEMORY MENU.

From now on when you are using the Category List, you will be able to use the imported icons in
your IMPORTS folder or find them in any other folder you may have selected to put them in.

Importing More than One Icon at a Time

Repeat steps 1-3 above.

Choose one or more bitmap files to import

21x

Lok irc [ 51 wINNT @ & cf BE-

| mwwaz Rhododendron.bmp
{1 Profiles @ River Sumida,bmp
D Reqistration Santa Fe Stucco.bmp
| repair Soap Bubbles. bmp
D security Zapatec.brp
1 shelllew
| 15peech
" sun
D system
D system3z
D Temp

) iI I » I
File name: I"F'railie “wind.bmp" "'Coffee Bean.bmp" ”Fealhej DOpen I
Files af type: [ Bitmap files [ bmp.". pg.*.if] =l Cancel /|

i

For step 4, hold down the <CTRL> key on your keyboard and click on the icons you want to

import, then select Open.
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‘.L' Yantage - ¥anguard PASS, Area b - 84-WordPower Demo - 4.03 Mar 3 2006
File Edit Options Tools Yocabulary  Help

IMPORT ICON MENU

[ Smr—mmmmmn.  3/686 3:56PM Caps Lock [

Shift
T =
¢y [T Speech 77

HOMNDACER

‘ Rename Icon

fMaintain Aspect Ratio,

i)

Help “ Cancel “ ‘ oK “

If you have a number of icons to import, you can select to import them one by one or have them
all imported at once. If you choose to have them imported all at once, you will see a screen like

the one below:

Import all icons without
asking about each one

=101 %]

‘.,{ ¥Yantage - ¥Yanguard PASS, Area 6 - 84-WordPower Demo - 4.03 Mar 3 2006

File Edit oOptions Tools Yocabulary  Help

IMPORT ICON MENU

[F %], 36486 3:56PH Caps Luckll:
Shift

1)) e crel =

m L Speech 77

5 Icons loaded. Assign all to the same
Category?
QYES _'
Rename Icon “

rHa intain Aspect Rati o,

asking about each one

Import all icons without “ ‘ Help “
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All your icons are now loaded in your IMPORTS folder. If you would like to assign all of them
to the same Category folder, select YES and then choose the Category. If want to assign each
one individually to a Category or just leave all the icons in your IMPORTS folder, select NO.

S Helpful Hint: 1f you have a large number of icons to import and you want to assign
them to Categories, you can import them in groups according to the categories you want to
assign them to. For example, 10 ‘friends' icons in the PEOPLE category; 5 'pets' in the ANIMAL
category; 15 'favorite foods' in the FOODS category, etc.

Load Icons from an MTI File

Perhaps you know someone who has a device with a lot of imported icons on it that you like.
This friend saves his device vocabulary, which includes the imported icons, as an MT] file and e-
mails it to you. You can load the imported icons from the MTI file into your device without
loading all the friend's vocabulary, too.

1. The MTI file must be available on your computer, either on a USB flash drive or an SD card.
Or saved in an "MTI" folder.

Go to the Toolbox and open the TRANSFER MEMORY MENU.
Select Load Icons from MTI File.

2

3

4. Go to the drive or file that contains the MTI file.

5. Double click on the MTI file you want, or click on the mti file and click on Open.
6

Your device loads the imported icons into the IMPORTS Category folder.

To see the imported icons you can use the Browse Icons option in the PASS Tools menu or you
can activate the Change Icon option in one of the Pathfinder's storing menus.
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Addendum: Reviewing Vocabulary/Dictionaries in
Vantage/Vanguard PASS

The VT-VG PASS allows you to review the vocabulary in any Area. You can also review the
Speech Dictionary, the Word Prediction Dictionary and Dynamic Activities. You can tell the
Vantage-Vanguard PASS to send a review to a folder on your computer where you can review it
at your leisure, save it to a different folder and/or print it out.

Below are directions for performing a vocabulary review from the REVIEW VOCABULARY
MENU. You can use these steps with only slight variations with the Review options in the

DICTIONARY MENU, WORD PREDICTION MENU and DYNAMIC ACTIVITY
MENU.

1. Gotothe VT-VG Toolbox and select the REVIEW VOCABULARY MENU.

7 BETA Vantage - Vanguard PASS, Mas 21 2006 - Asea 2 - Unily 45 Two Hit

[ [ e 71206 | 44PN Caps Lockl
EI Bhift I | |

Chel l‘-

| ﬁ m"... Spench

SELECTION

TECHIQUE RTINS

MEMORY

TRANSFER 'WEI:"I-'H 'EI“F-IEFE SPEARKER
WI.I'E

VANTAGE/VANGUARD PASS MANUAL
62



2. Inthe Review option, select the vocabulary you want to review: All, Activities, Core
or Pages.

% BETA Vantage - Vanguard PASS, Mas 21 2 ot - Auea 2 - Un. o 45 Two Hit
P R
Fe= - QOptons Jook © Help

R Caps Look I |

| miT———- Bhift I

b cret |

ﬁ Bp-nm:h“ |
J—Tq.lu‘rvmﬂ ﬂutn—upda‘t-—‘ f—bafa Lngging:_

e
o ) )4 ] 1
el e

I Cl=ar [ata Log
REVIEW T DISFLAY & SPEAKER o Byt

I REVILW TO OUTPUT MLTHOD

- SEEEEE————... o

3. Select the Review to Output Method option and select OK.
Make a note of the Area you are currently using. It will be listed at the top of the PASS screen.
You will need to know this later.

NOTE: If you just want to see the review on the screen, select Review to Display.

4. You will see a yellow box that says, "Please wait. Busy sending data...." PASS is sending the
review to a folder named VocabReview on your computer. When the yellow box has
disappeared, select OK.

NOTE: Some reviews, such as a Dictionary review, will take much longer to perform than an
Area vocabulary review.
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7 BETA Vantage - Vanguard PASS, Mas 21 2006 - Asea 2 - Unily 45 Two Hit

Ei=

24 Dptioms  Took 2 Hein

"REule VOCABULARY MENU u

TAARAE 2:3TPH

Caps Look [ |
BhiFt I |
Crrei |
Rp-u-uh- |

—
_:le aw Method — =

Bt

Please wait...

Busy sending serial data. ..

Cancel |

a_-hn Lugulny:_

3
ji e B

HEVIEW TO DISPLAY | l

Search Ioon Tukor

J

Save Daks Log |

-

REVIEW TO DISPLAY & SPEAEKER |

REVILW T OUTPUT METHODR ﬂ

e
oo

- J

Find the VocabReview Folder on your Computer:

5. Go to the main drive on your computer. This is probably the "C" drive. You can open this
drive by using "My Computer" or Microsoft Explorer.

6. Open the folder named Program Files.

7. Open the folder named Prentke Romich Company.

8. Open the folder named Vantage-Vanguard PASS.

9. Open the folder named VocabReview.

10. You see a folder for each Area in the VT-VG PASS. Open the folder for the Area you just

reviewed.

11. You see the text document(s) that contain the review(s).
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CE————— ;i

File  Edt Miew Favoste: Toos Heb -
4= Back = G hSeach O Folde: of ol W
Address | 2 ] @#6a
Foldarz = ¢ 'E'"".' r e
1 PC Patilinder [Franch) = | = 5
] FC SpangBioard Actwitins bt Coeocabul. Diclionan bd Dynamicicti. Pages.b

| Sparch Bingual S porgBosd
1 SpiingBoard Developer's Az
_1 SpringBloard PASS
| ‘Wankage ol Windows
| antapa'Wanguard Developer
1 Warkage Y anguerd PASS

_| help
#  ICoNS
+ 2] Motebooks

+ (] RSP J
1 5STEM

+ ] oo

= _| WocabM eview

i

e
Py T _
5 obysct(s] Dk fnee space: 97,2 GB) 79 KB = My Computer

12. You can open and print the documents from your computer or save them to a different folder.

IMPORTANT NOTE! Any time you do a review, the newest review will overwrite the older
review in the folder. If you want to save a particular review, save it to a new folder on your
computer.

Using these steps you can perform any review in the VT-VG PASS.

About Reviewing Dynamic Activities:

If you open the DYNAMIC ACTIVITY MENU and select Review Dynamic Activities, you
will see a list of all the Dynamic Activities in your Area. Select More Items until you come to
the last page of the list (the page will no longer change). Then select Cancel. This sends the
review to the VocabReview folder on your computer.
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Addendum: Creating ""Special Characters' in PASS

Perhaps you are using Write With Icons in the Spanish bi-lingual SpringBoard. You type in the word
"pifiata” only you don't know how to type in the " fi " from your keyboard.

The " fi " is a special character. For our purposes, Special Characters are generally used in languages
other than English. You can type these characters from your computer keyboard or a laptop
keyboard, but you have to add a couple of steps to get them typed.

Below are the directions for typing Special Characters. There is also a list of the special characters
and the numbers or letters to use to type them from both a desktop computer keyboard and a laptop
keyboard.

To Type Special Characters in PASS from a Numeric Keypad on a Desktop Computer
Keyboard:

1. Turn NUM LOCK On on your keyboard. This usually means pressing the key under the words
NUM LOCK (or Num Lock) until you see a green light above it. This tells you that your numeric
keypad will generate numbers.

2. Hold down the ALT key - keep holding it down until ALL FOUR digits are entered (next step).

3. While holding the ALT key, on the numeric keypad type the 0 (zero) and then the three-digit code
for the character you want. For example: i = ALT 0241.

NOTE: On some desktop keyboards, you may have to hold down a second key along with ALT
before the numeric keypad will generate numbers. This is usually the Fn key or the CTRL key. If
you try typing a number holding down only the ALT key and you don't get what you want, try ALT
Fnor ALT CTRL. You will have to hold down both keys while you type in the four-digit number.

To Type Special Characters in PASS from a Laptop Keyboard

Laptops do not have a set-apart numeric keypad area like most desktop keyboards. The numeric
keypad is incorporated into the regular keyboard keys. On most laptops the numeric keypad keys
can be found as follows:

0 is on the M key

1,2, 3areonthe J, K, L keys
4,5, 6 are on the U, I, O keys
7,8,9areonthe 7, 8, 9 keys
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To Turn the Numeric Keypad On

Find a small key, probably in the top row of keys, that says "num Ik" (or some similar abbreviation
for Num Lock). The key may also have a second function on it. The letters will be tiny and may be
in blue or surrounded by a white outline. This tells you that you need to press another key to access
the function on the Num Lock key.

Once you find the Num Lock key, look for the special function key that matches the Num Lock
key. On an N800 (PRC consultant) laptop, Num Lock is outlined in white. The Fn key on the lower
left side of the keyboard is also outlined in white. On the N800, you will hold down the Fn key and
press the Num Ik key to turn Num Lock On. Num Lock is on when you see a light under the little
padlock with a "1" in it.

On some computers the writing on the Num Lock key is blue and the writing on the Fn key is blue.
On some, the writing is just smaller than any other text on the same key. This probably means that
you use the SHIFT key in conjunction with the Num Lock key.

Once you see the Num Lock On indicator light, open a document. Hold down the ALT key (or
ALT Fnor ALT CTRL, depending on your computer) and type MKUJ (0241). You will see the "Ai"
character.

Special Character Computer Numeric Keypad Laptop Keyboard
R 223 MKKL

; 191 MJ9J

a 224 MKKU

A 192 MJ9K

a 225 MKKI

A 193 MJIL

a 226 MKKO

A 194 MJ9U

a 227 MKK7
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A 195 MJ9I

& 228 MKK8
A 196 MJ9O
& 229 MKK9
A 197 MJ97
® 230 MKLM
/E 198 MJ98

C 231 MKLJ
C 199 MJ9J

e 232 MKLK
E 200 MKMM
é 233 MKLL
E 201 MKMJ
e 234 MKLU
E 202 MKMK
& 235 MKLI
E 203 MKML
i 236 MKLO
[ 204 MKMU
i 237 MKL7
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i 205 MKMI
i 238 MKL8
T 206 MKMO
i 239 MKL9
| 207 MKM?7
A 241 MKUJ
N 209 MKM9
0 242 MKUK
0 210 MKJM
6 243 MKUL
0 211 MKJJ
) 244 MKUU
0 212 MKJK
0 245 MKUI
o) 213 MKJL
0 246 MKUO
0 214 MKJU
o 248 MKU8
@ 216 MKJO
0 249 MKU9
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217 MKJ7
250 MKIM
218 MKJ8
251 MKI1J
219 MKJ9
252 MKIK
220 MKKM
253 MKIL
221 MKKJ
254 MKIU
222 MKKK
255 MKII
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Addendum: New Features in PASS Software Version 4.05

Activity Row Background Color
You can change the background color of your Activity Row.

Go to the Toolbox.

Activate the MODIFY ACTIVITY menu.

Select the Activity Background Color key.

Select a color and activate OK to exit.

The color remains the same for all Activity Rows until you change it again.
NOTE: Do not use the SETUP key for this option.

Block Scanning

This scanning technique divides the overlay in four quarters. You select a quarter. Then an area
within the quarter. Then the column or row and the key you want.

Go to the Toolbox.

Open the SELECTION TECHNIQUE MENU.

Select either the 1-Switch or the 2-Switch option in the Selection Technique box.

In the Scan Direction box, select either Quarter Row/Column or Quarter Column/Row.

Word Power™ Demo

IMPORTANT NOTE! The Word Power Demo uses all six areas in your device. If you have
customized the vocabulary in any Area and you want to save it, perform an MTI to save the area (or
the whole device) before you load the Word Power Demo.

The Word Power Demo is for demonstration only and cannot be used with the MTI.

To Load the Word Power Demo

Go to the Toolbox.

Select the CHOOSE OVERLAY MENU.

Select the Overlay Menu option.

Select More Items.

Select Load Word Power Demo-All Areas.

You see a message box asking you if you want to erase all areas. Select YES to continue or NO to
exit. If you select YES, all 6 User Areas will be erased and Word Power will be loaded into the
Areas.

When Word Power is loaded you will be using the Word Power word prediction dictionary which is
different from the VT-VG word prediction dictionary. Should you re-load the VT-VG word
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prediction dictionary (from the WORD PREDICTION MENU) into a User Area, Word Power will
not be able to use Word Prediction the way it was designed to.

To Re-load your own Areas

Open the MAINTENANCE MENU.

Select Reset to Factory Defaults.

Select YES.

(This will also re-load the VT-VG Word Prediction Dictionary.)

Or, you can load vocabulary from the CHOOSE OVERLAY MENU, Area by Area. If you choose
to do this, you will have to re-load the VT-VG Word Prediction Dictionary from the WORD
PREDICTION MENU.

Or, if you saved your memory using the MT]I, you can use the MTI and the TRANSFER
MEMORY MENU to load the saved file(s) back into your device.

Zipped E-Mail

If you select E-Mail from the PASS Options menu, PASS will now automatically zip any file
before placing it in the e-mail.
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